Table of contents

Lookeen — Your Complete Outlook and Desktop Search ............ccevvvvviiiiiiiiiiiiiiiinnnee. 5
T 1Sy e= 11 F= (T o PSPPI 6
THE MaAIN MENU.....ouiiiiiieii et et e e e e e et e e e e e et e e e e e et e e e eaaaaeeeene 8
1P 8
o L] OO PO PUPPPPPPPPPR: 8

KT = URPPPPPPIN 8

e (ST PP 8
[MBGE PIEVIEW ... s 8
PrevieW 0N MOLION ......cooiii e e et e e e e e e eaaaaas 9
CUSIOMIZE COIUMNS ...t e e e e e et eeeeaaaans 9

H IS0 e 9

= V0 (] (=T PPPPPPRRPPPIN 10
10T = OO RPPPPPRRPPPIN 12
OPTIONS. .. 13

(L [ ) 13
LIRS T=T= U o T = T 14
AL R G 0SS A - U 15
RESUIL TYPE SEIECHON ......cceeeeeeeece e e e e e e e e e e eeeaanns 15
SEIECE COIUMNS ...ttt e e e e e e ettt e e e e e e e e e aeeaaa s 15
Change preview detailS............iii i e e 16
Advanced search fields — Hide or Unhide ............cccoooiiiiiiiiiiiiiiii e 16
Advanced Search fleldS .........ccooiiiiiiii e 16
The CONEXE IMENUL......oeeiiiiii e e e e e e e e e e e e e e et e e eeaaes 18
(@70 1Y/ T £57- (o] o [P 18
CONVErSAtioN WIth .....ccoiieiici e e e e e e 18
Mails to and MalilS frOM...........uuiiiiiiie e, 19

JL 10 o[PS 19
TIMESPAN BEIWEEN......euiiiii et e e e e e e 19
Extract email addreSSES .......uuuuiiiiieiiiieeee e, 19
Repeat search including only.... .......ooooiiiiiiii e 19
Repeat search NidiNg...........ouuuiiiiiiiii e a e 19
SUMMATIZE ..eei ettt e et e e e e et e e e e et e e e e et e e e e et e e e easanas 20
Move to folder, Copy items to fOlder ........cooviiiiiiiii e 20
DIt IHBIM .. 20

(@1 1= T0 (0] 1 7 20U 20



Reply, Reply All; FOrWard ... 20

CUSTOMIZE COIUMNS ...t e e e e e e e e eeaa s 20
THE DELAIIS ATC@... .o e e e e e e e et e e e e e aes 20
LI ] oo PP PP PPPPPPPPPPPPPP 21
(@70] g1 V/=T £57= 11 To ] o [P 21
SeleCt PreVIEW MOUE.........ooiiiiiiiiiiiiieee et 22
Edit dOCUMENTS ... e et e e e e e e e e e aea e e e e e e e e eeennnes 22
LIRS €= L S = - O 23
OPTIONS .o 24
0T 1 24
o [0 S (o] = 25
REIMOVE ... ettt e et et e et e e e e eeans 27
Edit 27
INAEXING SCREAUIE.......eiiiiiiiie e 28
Index items automatically, every and Clear index automatically, every............. 28
Don’t perform index from and ‘Start indexing only during .................c..coeeeee. 28
Minimum time between indexing and Minimum time before first indexing starts 29
Real-time INAEXING .....coie e e e e e e e e e e et e e e e e e aeeennnees 29
10 1= QD= =T £ 29
Local index data Path ............uuuiiiiiiiiiiieei e 29
INdeX fileS WIth @XIENSIONS .......uuiiii e 30
Regulate the speed of the iINdexing ProCesS...........uuuuviiiiieeeeeieeiiiiiiiee e eeeeeeeienns 30
AlWayS OPLIMIZE INAEX ... e e e e e e e 30
Maximum Characters iN PreVIEW ...........euuuuuuiiiieeeeeieeeiiiiis s e e e e e e eeeeatnaaseeeaeeeaennnns 30
SBAICN. .. 30
Enable global shortcut (Ctrl, Ctrl) to start Lookeen from Windows .................... 31
Enable shortcut (Ctrl-F) within search dialog.............ccceeiiiiiiiiiiiiiiiiie e, 31
Use search history to store your search qUENES .........cceeeveeeeiiieeiiiiiiiieeeeeeeeeeiens 31
Activate ‘Search-as-you-type mode.............ccceeeeiiieiiiiiiiiii e 31
Repeat search with * -wildcard, when no search result...............cccoooeeeieieiinnn, 31
Repeat search with * -wildcard at begin of query when no search result........... 31
Always use *-wildcard at begin of QUEIY ..........ceeiiiiiiiiiee e 31
Your Email addresses and Aliases of yourself ............ccccoviiiiiiiiiie, 32
Maximum results to return on each Search..........ccccuvviiiiiiiiiiiiiiie e 32

L@ 111 (o o PP PTTPTRR 32
INdeX OULIOOK CatEQOrI€S .......ciiviiiieieeii e 32
INdeX AttACNMENTS......i e 32

Skip junk folders and 'Deleted Items' folders...........ccoeeviiiiiiiiiiiiiie e, 33



SKIp €NCrypted IEMIS ....cooiiiiiiiiiiiiieeeeeeeee et 33

Open Outlook When Needed............oovvvviiiiiiiiiiiiiiiiiiiiiieeeeeeeeeeeeeeeeeeee e 33
Detect new Outlook archives when Outlook starts ............ccccoeeeiiii, 33
Show confirmation dialog .........cooevviiiiiiiiiiiiiiieee 33
Add new archives to indexing by default ..............ccccooiiiiis 33
)1 (=T 1 1 PP PP PPPPTTPP 33
SEttiNGS IOCALION ....coeviiiiiiiiii ittt 34

Do not index if one of these (slow) networks is active (network blacklist).......... 34
Confirmation dialog before indexing if a slow network is active..............cccc........ 34
(=T [0 | U E= T [PPSR 34

Log File Detail LEVEI ... 35
Check fOr UPAAtES ......cooviiiiiiiiiiii e 35
ShOW iCON IN SYSTEM TrAY ....coiiiiiiiiiiiiiiiieieeeeeeeeeeeeeeeeeeee et 35
Show balloon popup INFOrMALION ........cceeevviiiiiiiiiiiiiiiieieeieeeeeeeeeee e 35
Show general WarningsS .........oooviiiiiiiiiiiiiiiiiieeeeeeeeeeeeeeeeee ettt 35
Automatic cache cleanup to miNiMize MEMOrY USAQE...........uuuuummmmmmmmmnnnnnnnnnnnnns 35
Show warning when application is closed while indexing .........ccccceeevvvvvviivnnnnnn. 35

LAY e [0 1YV [T (=0 = T o 36
(@101 [oTo) Q[ 01 =T | =1 (o o 1S 37
Lookeen in the Outlook RIDDON ... 37
The Lookeen Search Dar ... 37
Search Words & QUETY SYNEAX......uuuiiiieeeiieiiiiiiiei e e e e e ettt s e e e e e e e e e eeata s e e e eeaeeeaennns 38
BASIC QUETY SYNTAX ....uuuiiiiieeieeeiiiiiiis s e e e e e e e eeeti e s e e e e e e e e ea et s s e e e e e e eeastssaeaeeeaeeennnnns 38
FaNo A7 T Lot =T I o [V L= =T 38
Additional SearCh NeIP.......coii i 38

[ T o T o] 1o 1SRRI 40
LOOKEEN USEI GUITE ...ttt s 40

(@ 0] (1 LIS U1 o] oo ] PP 40
Y=o [ = 0o i SR 40
ChecCK fOr UPAAteS .......ccoieeeeeie e e e s 40
210N VA= T o I =T o | ] (= (PSP URRRPPPPPPRR 40
LI L= 3 1 o IO PP PPPPPPPPP 41
ADOUL LOOKEEN ...ttt s 41
External Index Sources (Shared INdeX) ..........uoiiiiiiiiiiiiiiiii e 42
OVEBIVIBW ...ttt ettt e e e e e ettt e e e e e e e e e e ettt e e e e e e e eeeaeenna s 42
Using the "Shared Index” fuNCHON...........oooiiiiiii e 42
Generate an external INAEX SOUICE .........uuuuiiiiieiiiiiiiiiiiee ettt 43

Searching with external INAEX SOUICES.........iiiiiiiiii i 43



Possible Application Scenarios

Browse PST files that are not included in the work profile .............ccccooiiiiiiiiiiinnnns



Lookeen — Your Complete Outlook and Desktop Search

& Lookeen Enterprise - +textmesting +text:farmer =HASE X

File Edit View History Favortes Index Options 7

-

[ Everything 2281) [ Msils (1963)  [| Attachments (318) Il = ~ & Topic /! Conversation Save -
Everythin= | Everytir= - - - + Local Archives = @ June Wellhead Prod Est
Type Date - Subject From To Folder Archive + Path: Archiv - christian.schmidt @axonic.net\ ENRON\farmer-d2\Darre
] ods Att... 23.05.20.. Consolidated_2000ls Discussion threads Archiv - christian.s.. From: Tom Acton

To: Daren ) Farmer
i Mail+  23.05.20.. June Wellhead Prod Est. Tom Acton Daren ) |Farmer Wellhead Archiv - christian.s...
&) s Att... 23.05.20... Consolidated_2000ls Wellhead Archiv - christian.s... ) Consolidated_2000.x1s

.

)z

FJMail  22.05.20.. MeterVolume Overrides Vvette G Connevey Howard B Camp; Clem ... | Discussion threads Archiv - christian.s.. e Forwarded by Tom Acton/Corp/Enton on
FJMail  22.05.20.. MeterVolume Overrides Vvette G Connevey Howard B Camp; Clem ... | All documents Archiv - christian.s.. 05/23/2000 06:58

) Mails  19.05.20.. Customer |Meeting Invitation Heather Choate  Briant Baker; Tricia Bow... Discussion threads Archiv - christian.s. AM

) Mail+  19.05.20.. Customer |Meeting Invitation Heather Choate  Briant Baker; Tricia Bow... All documents Archiv - christian.s..

) Mail+  19.05.20.. Customer Meeting Invitation Heather Choate  Briant Baker; Tricia Bow... Logistics Archiv - christian.s.. Vance L Taylor@ECT

3 Mail 19.05.20... HURRICAME SEASON PLANNING M, Esther Buckley Edward D Gottlob; Lauri...| Discussion threads Archiv - christian.s... 2_5-119_10031(1-096%-“&“ ——

A Mail  19.05.20.. HURRICANE SEASON PLANNING M. Esther Buckl Edward D Gottlob; Lauri...| All documents Archiv - christian.s.. o Lom ActonLofp =nron! o

FMail  19.05.20.. Meetwith Dwight Dawson - EB2133 N Meeting s Archiv - christian.s.. ce: Metissa Graves HOUECT@ECT

CdMail  18.05.20.. Meet on Web page Meeting s Archiv - christian.s.. Subject: June Wellhead Prod Est.

[Mail  18.05.20.. |Meeting Room Change -PRC Fee.. JanetDelaPaz  BrentA Price; SteveJac.. Discussion threads Archiv - christian.s.. =
=IMail  18.05.20.. |Meeting Room Change -PRCFee.. JanetDelaPaz  BrentA Price; Stevelac.. All documents Archiv - christian.s... Tom,

) Mail+  18.05.20... Deadlines - 2000 Customer |Meeti.. Heather Choate  Daren) |Farmer Logistics Archiv - christian.s.. Please see the attached file estimating wellhead production for
) s Att... 18.05.20.. Guest Listxls Logistics Archiv - christian.s.. the manth of

() Mail+ ~ 18.05.20.. Deadlines - 2000 Customer |Meeti.. Heather Choate  Daren) |Farmer All documents Archiv - christian.s. g‘ﬁ‘iﬁxebﬂ advised that this is a preliminary estimate as [
] ods Att... 18.0520... Guest Listals All documents Archiv - christian.s.. meet with the gas buyers (the meeting is Monday at Jpm) and
()| Mail+  18.05.20... Deadlines - 2000 Customer |Meeti.. Heather Choate  Daren) |Farmer Discussion threads Archiv - christian.s.. to this date we

) s Att... 18.05.20.. Guest Listxls Discussion threads Archiv - christian.s.. have not received any noms for June. [ will update you with
FAMail  17.0520.. Re: [Meeting Confirmation - Ma.. Michael Eiben Daren ) Farmer Logistics Archiv - christian.s... xgif:‘c‘:;:“s“

FMail  17.05.20.. Re: Meeting Confirmation - Ma... Michael Eiben Daren ) [Farmer All documents Archiv - christian.s.. 7 :

CdMail  17.05.20.. Re: Meeting Confirmation - Ma... Michael Eiben Daren ) [Farmer Discussion threads Archiv - christian.s.. Thanks

CdMail  17.05.20.. |Meeting Confirmation- May18  Daren) Farmer  Michael Eiben Sent Archiv - christian.s..

Mail  17.05.20.. |Meeting Confirmation- May18  Daren) Farmer  Michael Eiben All documents Archiv - christian.s... :31‘_6353

FJMail  17.0520.. |Meeting Confirmation- May18  Daren) Farmer  Michael Eiben Discussion threads Archiv - christian.s..

FJMail  17.0520.. |Meeting Confirmation- May18  Daren) Farmer  Michael Eiben “sent mail Archiv - christian.s..

@] .doc A... 17.05.20.. Controls Review.doc Sent Archiv - christian.s..

] .doc A... 17.05.20.. Controls Review.doc All documents Archiv - christian.s. e
W .doc A... 17.05.20.. Controls Review.doc Discussion threads Archiv - christian.s.. ™

2281 items found 1 selected 89774 items

Thank you for installing Lookeen. Lookeen enables you to search your Outlook data,
as well as your file system. This includes emails, conversations, contacts and much
more.
Lookeen helps you organize your daily work flow. You receive and write countless
emails every day, which can quickly add up to a lot of time wasted sorting your Inbox
or searching for important information in your archives.

= Searches PST archives, MS Exchange Server, local and network files

= Searches in e-mails, attachments, appointments, tasks, notes, contacts, and

journals
= Complete desktop search, even when Outlook is closed or not installed

= Zeitersparnis bei der Organisation und beim Ablegen von Outlook Elementen

= Saves time when you organize your files or Outlook elements



Installation

After accepting the license agreement, you have the option to select the destination
folder for the installation:

Setup - Lockeen [ = ﬁ

Select Destination Location
Where should Lookeen be installed? A

J Setup will install Lookeen into the following folder.

To continue, dick Mext. If you would like to select a different folder, dick Browse.

:\Program Files (x86)WAxonic\Lookeen Browse...

At least 77,2 MB of free disk space is required.

[ < Back “ MNext = ][ Cancel ]

If you want something other than the default location for the installation, you can
enter its path directly or use the “Browse” button to navigate.

In the next window you can specify the folder in the start menu in which to add the
Lookeen program shortcut:



Setup - Lockeen |. = i e

Select Start Menu Folder
Where should Setup place the program's shortouts? A

E i Setup will create the program's shortcuts in the following Start Menu folder.

To continue, dids Mext. If you would like to select a different folder, dick Browse,

Browse...

[ < Back ][ Mext = ][ Cancel ]

You can then choose whether Lookeen should make a shortcut on the desktop, if
Lookeen starts automatically each time Windows starts, and whether Lookeen should
be installed as a pure Outlook plugin. If installed as a pure plugin, Lookeen can’t
operate independently, but is started and stopped with Outlook. The functionality of

Lookeen is not affected; even as a pure Outlook plugin, Lookeen offers full desktop
search capability.

Setup - Lockeen [ = &J
Select Additional Tasks
Which additional tasks should be performed? A

Select the additional tasks you would like Setup to perform while installing Lookeen,
then dick Mext.

Additional icons:

[7] create a desktop icon

[7] Add to Windows startup

[ Install as pure MS Qutiook plugin

< Back ][ Mext = ][ Cancel




The Main Menu

In the main menu, you can add actions for selected items, customize the layout of the
Lookeen window, or start the indexing process manually:

File Edit VWiew History Favorites Index  Options 7

File
In this menu you can completely stop Lookeen by selecting "Exit".

Edit

Here you have the most popular Lookeen functions at hand: "Start Search”, "See
conversation with selected person”, "Topic" and "Summarize".

You can also use popular Outlook features directly from Lookeen, such as: reply,
categorize, delete, etc.

View
This menu allows you to customize the way Lookeen search results are displayed.

Preview

With Lookeen you can display a preview of your search results, and enjoy the familiar
look and feel of Outlook. You have the choice of displaying the preview to the right or
below your search results.

Simply go to “View" -> “Preview*

W Lookeen Enterprise - +textmeeting +text:farmer

File  Edit | View | History  Favorites  Indexer  Options 7

| Preview » Off
Image preview b . Right |

| Preview on Motion Bottom
Ever}-thing Customize Colummns... achrments (320)
Everything -  Everytir- - -
Type Date - Subject From To
=4 Mail 1511.20... GISBIR Meeting Motes Jaquet Tamrmy Calcagno Su
-4 Mail 141120, Meeting Superty Superty: Rob

Image Preview

With Lookeen you can also display image files such as JPG, PNG, BMP (etc.). Use
this menu to select how the images are displayed. You have the choice between



"Zoom" (stretched to the size of the preview window), “Center” (centered in original
size in the preview window), or "Off".

Preview on Motion

With "Preview on Motion" you can choose whether the preview pops up when you
hover the cursor over the item, or only when you click on it.

Customize Columns

You can select the columns that appear in the results page. By clicking "Customize
Columns" a window opens in which you can make your choice:

Select Columns @

{Subject ["] File Extension
To [[] Location
Folder

From

Size

Start

MName

Company

Birthday

File

Cue Date

Path

Sent

Received

Indesced

Modified

Created

Sensitivity
Conversation Index
Categories

PST Path LNC
First name

Phone

OOEEEEEEEEEEEEEEE OO EEEE]

OK || Cancel

History

Lookeen remembers your previous searches. Here, the last 21 searches will be
saved regardless of search success. You can easily re-select previous searches by
clicking on "History".



W Lookeen Enterprise - +text:lockeen +text:10
File Edit View | History | Favorites  Indexer  Options 7
Back Alt+B
look Forward Alt+F
s Clear History
Everything {4605)
. e +text:lookeen +text:10
Everything - | Everyt +text:lookeen +text:10 +date:[20141201 TO 20141231)]
Type Date +text:meeting +text:farmer
| b Attac.. 140126 text:tenaska
&l Mail+ 14.01.21 +textiinvesting +text gabrielson
04 mail Atta... 14.01.20 text:gabrielson
b9 Mail 13.01. +textproject +ext:pdf
B=d Mail 13.01.2( - Suppor
64 Mail 13.01.21 : — -

You can select "Clear History" to delete the search history and get a better overview.
You can disable the history function in options:

A7 Options

| Indexer | Index Schedule I Index D'etails| Search | Outlock | S]Irsteml

Enable global shortcut (Ctrl, Ctrl) to Start Lookeen from Windows
Enable shortcut (Ctrl-F) within search dialeg

Use search history to store your search queries

Activate 'Search-as-you-type' mode

Favorites

Search favorites were developed for instances where the database that is searched
changes frequently, but the queries remain the same. You can save and organize
your most frequently used search criteria.



Enter your search term and then go to "Favorites" -> "Add to Favorites ..."

.

A Lookeen Enterprise - +textlockeen +text:10 +date:[20141201 TO 20141231]

File  Edit View Histor_l.f_ Favorites | Indexer  Options 7

| Add to Favorites... |

10 date:[20: Organize Favorites...

[*»] Everything (178) A Mails (103)  [|| Attachments (75)

| PP 1 T | PP ey

Your search parameters are set in the following field. Now you can assign a name
under which the query should be saved.

-

a7 Lookeen Enterprise - +textlockeen +text:10 +date:[20141201 TO 20141231]

File  Edit View History Favorites Indexer Options 7

lookeen 10 date:[20141201 TO 20 ~

Everything (178) B Mails (103) (I add Favorite =
SR v | e T Mame: L10 December 2014

Type Date v Subject | g en +text lookeen +text 10 +date 20141201 TO 201412

54 Mail 20122014 20:25  RE: Still

=) Mail+ 2612.201418:02  Fwd: AW

[ .png Atta.. 26122014 18:02  imagel0
(B .png Atta.. 26122014 18:02  imagel

Click the "Favorites" menu to see and select saved searches.

-
A Lookeen Enterprise

File Edit View History | Favorites | Indexer  Options 7

Add to Favorites...

Organize Favorites...

L10 December 2014 - +text:lookeen +text:10 +date[20141201 TO 20141231]

In the "Organize Favorites ..." menu, you can edit, rename, delete or change the
order in which favorites appear in your list.



-
A Organize Favorites

Favartes:

MName Query

+#eadt lookeen +ext: 10 +date:[20141 ..

Remove

Remove all

“E H !

oK | | —

Index

In order to search your data, Lookeen creates an index of your email messages,
contacts, calendar entries, and your file system. Lookeen manages this index
efficiently and unobtrusively in the background. During the indexing stage it uses a
minimal amount of the computing capacity, so that you can continue to work
unhindered while the index is created.

-
A Lookeen Enterprise

File  Edit View History Favorites | Index | Options 7
b Start
Stop

Pause
% Build new index

Everythin= | Everytin- Details

Type Date = Subject From

In the "Index" menu, you can start, stop or pause the indexing process.

You can click the "Start" button to start the indexing process manually. Generally, you
don’t need to do this because the default settings will perform the indexing
automatically.



When you click "Pause”, indexing will be stopped for an hour. After one hour, the
indexing will automatically resume or you can simply click "Next" to continue
indexing.

If you don’t want Lookeen to index now, you can click the "Stop" button. It may take a
few seconds for the index operation to stop. The indexing process will stop and your
index will remain in a usable state. When you're ready to resume indexing, you can
click the "Start" button or simply wait until the scheduled automatic indexing operation
starts by itself. If you cancel or stop indexing, you do not have to start all over again
the next time - Lookeen remembers the point where you left off and jumps to that
position. You can also close Outlook during an indexing process — Items which were
already indexed won'’t be lost!

You also have the ability to completely rebuild the index, i.e. to delete, and then start
the full indexing from the beginning.

Options

Open the options window by clicking on "Options". The options are described in detall
in a separate section.

? (Help)
This menu allows you to find help options, which are described in a separate section.



The Search Bar

Enter your search term in the search bar. If the "Search-As-You-Type" option in
Options -> Search is enabled, Lookeen will start searching as you type. Otherwise,
enter the search term and press Enter or click the magnifying glass to start the
search.

Lookeen remembers your search queries (see also Main Menu -> History). Click on
the arrow icon in the box to open the list of search terms you have already entered.
On the left side of the search bar you will find the arrow buttons that let you move
back and forth through the list. Next to it is the delete button X, which lets you reset
the search, i.e. you delete the entered search term and all other search criteria.



The Results Area

In the results area you'll see all items that match your search criteria. The default
number of results displayed is limited to 5000. You can increase the maximum
number in Options -> Search.

Everything (2280) [0 Mails (1963)  [| Attachments (317)

Everythin= | Everytime - -

Type Date - Subject From
=4 Mail 07.02.2000 2... *RESCHEDULED* Internal Pool M.. Heather Choate
=4 Mail 07.02.2000 2... *RESCHEDULED* Internal Pool M... Heather Choate
=4 Mail 06.,02.2000 0... Some after thoughts to our mee.. Mauldin Mike
=4 Mail 06.02.2000 0... Some after thoughts to our mee.. Mauldin Mike
4 Mail 06,02.2000 0... Some after thoughts to our mee.. Mauldin Mike
4 Mail 05.02.2000 0... HPLC/EMA employees meeting Yvette G Connevey
(=9 Mail 05.02.20000... HPLC/EMA employees meeting Yvette G Connevey
@ .ppt At.. 04.02.2000 2... Three Rivers Allocations Mtg..ppt
g] .ppt At.. 04.02.2000 2... Three Rivers Allocations Mtg..ppt
EIi_J] Mail+ 04.02.2000 2... Motes from initial ENom Use Case 1 Hal Elrod
B .doc A... 04.02.2000 2. EMom initial pass use cases.doc
ElU] Mail+  04.02,2000 2... Motes from initial EMom Use Case 1 Hal Elrod
lﬂ_].doc A.. 04022000 2... EMom initial pass use cases,doc

ElU] Mail+  04.02.2000 2... Motes from initial EMom Use Case 1 Hal Elrod

B .doc A... 04.02.2000 2. EMom initial pass use cases.doc

[ Mail 04.02.2000 2... Meet with Mike Mulden in Cafete...

4 Mail 04,02.20001... MidTex Meeting Thu Mguyen

4 Mail 04.02.20001... MidTex Meeting Thu Mguyen

(=9 Mail 04.02.20001... Brenda Herod's Management Off... Yvette G Connevey
=4 Mail 04.02.20001... Brenda Herod's Management Off... Yvette G Connevey
(4 Mail 04.02.2000 1... Review Texas Budgets (3084)

4 Mail 03.02.2000 2... Re: MidTex meeting Daren | Farmer
(=9 Mail 03.02.2000 2... Re: MidTex meeting Daren ) Farmer
=4 Mail 03.02.2000 2... Re: MidTex meeting Daren ) Farmer
=4 Mail 03.02.2000 2... Re: MidTex meeting Daren ) Farmer
4 Mail 03.02.20001... MidTex meeting Thu Mguyen

(=9 Mail 03.02.20001... MidTex meeting Thu MNguyen

=4 Mail 03.02.2000 0... Usecase Analysis for Enom  Meet..,

=4 Mail 03.02.2000 0... Usecase Analysis for Enom  Meet..,

4 Mail 03.02.2000 0... Usecase Analysis for Enom  Meet...

[ Mail 02.02.20001... KERR MCGEE meeting TODAY .. Daren) Farmer

To

Randall L Gay; Katherine L Kelly: ...
Randall L Gay; Katherine L Kelly: ...
Daren ) Farmer
Daren ) Farmer
Daren ) Farmer

Daren) Farmer : Pat Clynes

Daren ) Farmer ; Pat Clynes

Robert Superty; Daren) Farmer :...

Robert Superty; Daren) Farmer ;..

Robert Superty: Daren] Farmer ;...

Aimee Lannou; George Grant; Ro...
Aimee Lannou; George Grant; Ro...
Steve Venturatos; Mary M Smith; ...
Steve Venturatos; Mary M Smith; ...

Thu Nguyen
Thu Nguyen
Thu Nguyen
Thu Nguyen
Aimee Lannou; George Grant; Ro...

Aimee Lannou; George Grant; Ro..,

Ami Chokshi

Folder

Discussion threads
All docurmnents
Discussion threads
Personal

All documents
Discussion threads
All documents
Discussion threads
All documents
Discussion threads
Discussion threads
Enron news

Enron news

All documents

All documents
Meeting s
Discussion threads
All documents
Discussion threads
All documents
Meeting =
Discussion threads
Sent

All documents
'sent mail
Discussion threads
All documents
Discussion threads
Meeting s

All documents

Discussion threads

~  Archiv -

Archive
Archiv -
Archiv -
Archiv -
Archiv -
Archiv -
Archiv -
Archiv -
Archiv -
Archiv -
Archiv -
Archiv -
Archiv -
Archiv -
Archiv -
Archiv -
Archiv -
Archiv -
Archiv -
Archiv -
Archiv -
Archiv -
Archiv -
Archiv -
Archiv -
Archiv -
Archiv -
Archiv -
Archiv -
Archiv -
Archiv -
Archiv -

m= ~

christian, =

christian.s...
christian.s...
christian.s...
christian.s...
christian.s...
christian.s...
christian.s...
christian.s...
christian.s...
christian.s...
christian.s...
christian.s...
christian.s...
christian.s...
christian.s...
christian.s...
christian.s...
christian.s...
christian.s...
christian.s...
christian.s...
christian.s...
christian.s...
christian.s...
christian.s...
christian.s...
christian.s...
christian.s...
christian.s...
christian.s...

christian.s... -

Result Type Selection
At the top of the results area there are tabs for the various category elements.

Evenything (10000)

=3 Mails (3316)

Contacts (650)

Tasks (1)

Appointments (303)

D Motes (1)

@Joumal (3]

[l Attachments (1265)

The results for each category are displayed by clicking on a tab. You can return to
the complete results list by clicking on the "All" tab.

Select Columns

To the right of the category tabs there are three buttons. Click the left one to select
the columns to be displayed (see Main Menu -> View -> Customize Columns)



Change preview details

With the middle of the three buttons, you can select how many rows of the content of
an element are displayed in the results area. By clicking this button, you can switch
between none, 1, 2 or 3 lines.

Advanced search fields — Hide or Unhide
You can turn the advanced search fields on and off with the button on the right.

Advanced search fields
With the advanced search fields, you can refine your search in many ways.
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Above the “Type” column is a drop down menu for the type of result to which you’d
like to restrict the search. You have a choice between “Everything”, "Mails”,
“Attachments”, “Contacts”, “Notes”, “Appointments” and “Files™.

Everythin~| Ewengtime -
Everything

Mails
Attachments

Contacts
Motes

Appointrents

O EUEEZR [F]

Files

Above the “Date” results column is a drop down menu for the date range to which the
search should be limited. You have a choice between “Everytime”, “Today”, “This
week”, “This month”, “This year”, and “Custom Interval”. Your search word is
searched only within the time limits specified by you. If you select “Custom Interval”,

the following window will open and you can enter your desired period.



' ™y
Restrict date range ﬁ

Start:
Donnerstag, lil.  Januar 2015 E-
End:
Donnerstag, 15. Januar 2015 El-

Search restricted to 14 days.

0] ‘ ‘ Cancel

Above the “Archive™ result column is a drop down menu for the archive in which the
search should be performed. You can search all of the archives that you have added
to your index. Multiple selections are also possible.

All Archives - | - -

All Archives

Local Archives

Archiv - christian.schmidt@axonic.net
christian.schmidt@axonic.net

Offentliche Ordner - christian.schmidt@axonic.net
LC10-PST

Ch

ey,

E:

P

Shared Archives

WERVDL sharesitauschiLockeen Shared IndexManuel\Reading
Server Archives

Private Mailbox

Public Folders

File System

Lookeen offers even more search fields that can help you narrow down your search.
These are:

e Subject, To (= recipient), From (= sender), Category: for the corresponding
email properties

e Folder: Use to limit the search to a single folder. It can be an Outlook folder or
a folder from the file system.

e Path: Similar to folder, only that here you must specify the path you want to
search. In contrast to searching a folder, subfolders will also be considered in
this search.

¢ Name, Company: For contacts



o File, File Extension: For Email attachments and files stored locally or on the
network
e Location: For appointments and meetings

Enter your search term in the respective search field and press Enter or click the
magnifying glass to start the search. The search fields can also be combined, of
course.

The Context Menu

Double-click on an item to open it. By right-clicking on an item, the context menu will
open with options to refine and restrict your search queries, as well as edit the
selected element.

Conversation

Conversation with Hill: Garrick;Farmer;
Mails to Hill: Garrick: Farmer:

Mails from Hill: Garrick:Farmer:

Tepic

Tirmespan Between

Extract Email addresses

Repeat search including only... *
Repeat search hiding... *
Summarize

Move to Folder
Copy items to Folder...
Delete itern

Categorize

Reply
Reply To All
Forward Mail

Customize Columns...

Conversation

To get an overview of all correspondence between you and another person, select an
email from the person and then select “Conversation”

Conversation with

If you want to get an overview of all correspondence between you and all persons
who have been a part of an email thread (e.g. as the sender, CC, or BCC), please
mark the e-mail and then select "Conversation with".



Mails to and Mails from

With the “Mails to” and "Mails from" selection, you can find all the e-mails "to" or
"from" the participants of the selected e-mail.

Topic
To start a search for a specific subject, check the appropriate email in your search
results and select "Topic".

Timespan Between
When you select two different emails in the Lookeen search result window, you can

click on "Timespan Between" - to get an overview of the correspondence between
the date of the first and second selected emails.

Extract email addresses
This function lists all email addresses contained in an email in an editor window. Both

the sender and receivers are detected, as well as addresses in the content of the
email.

Repeat search including only....
You can narrow down your search results by clicking "Repeat search including only

This allows your search query to be limited by only looking at emails with the same
sender, subject, store, in the same folder, or those that are received on the same
day, week or month. (The date refers to the selected email in your Lookeen search
result window).

Extract Email addresses

| Repeat search including only... 3 Sarme Sender
Repeat search hiding... » Same Subject
Surnmmarize Same Store

Same Folder

Mowve to Folder
Copy items to Folder... same Day
Delete item Same Week
Categorize Same Month

Repeat search hiding...

You can refine your search results in a similar way using the "repeat search without
..." button. As a result, only elements without the same sender, subject, store or
folder will be included in the new search results.



Extract Email addresses

Repeat search including only... 3
Repeat search hiding... r Same Sender
Summarize Same Subject

Same Store
Move to Folder

Same Folder

Copy items to Folder...

T |

Summarize

Click on "Summary" to create an email that summarizes the correspondence of all
selected emails in list form.

Move to folder, Copy items to folder

Do you want to move or copy an email to another Outlook folder? Simply select the
relevant email in the Lookeen search result window and click "Move to Folder” or
“Copy items to Folder” in the context menu, then select the destination folder.

Delete Item
This allows you to delete the selected item.

Categorize
If the selected item is an email you can set a category here.

Reply, Reply All, Forward
These are the same as the usual actions that you perform with emails.

Customize Columns

This opens the “Select Columns” window where you can choose which columns are
displayed in the results area.

The Details Area

When you select an item by clicking on it in the results list, it will be displayed in the
details area.
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= Bad Debt

Path: Archiv - christian.schmidt@axonic.net\ EMREOMN farmer-d1'Darren_Farmer_Jan2002'Farmer, Dai
From: Wallis Janet

To: Larnphier Gary; Papayoti Lee
CC: Redmond Brian; Hall Bob

Please plan to attend a meeting with Brian Redmond and Bob Hall on Thursday at 4:00 in
conference room 3367

Each person should be prepared to discuss the current status of each "Bad Debt" account
that was assigned to them in February.

If vou are unable to attend vou will need to schedule a private meeting with Brian Redmond
at a later date.

Janet

REE R R L EE LS

EDEM Enron Email Data Set has been produced in EML, PST and NEF format by ZL
Technologies, Inc. This Data Set is licensed under a Creative Commons Attribution 3.0
United States License <http://creativecommons.orglicenses byv/3.0/us> . To provide
attribution, please cite to "ZL Technologies, Inc. (hitp:wanw 2t com)."”

e e e ke ok ke ok ok ok ke ke

Topic

If it is an email or an email attachment, you can display all further emails with the
same or similar subject line using the "Topic" button.

Conversation

The "Conversation" button lists all correspondence involving the people included the
selected email.



Select preview mode

Using the "Select preview mode" button on the far right hand side, you can determine
how elements are displayed in the preview: either “Show preview of document”,
“Original document (read-only)” or “Original document (Edit mode)™. While the pure
text preview offers the advantage of instantaneous preview, the original preview
shows the document as it appears in the associated application after it has loaded.

Edit documents

To do this, select “Original document (Edit mode)”. You can edit the document within
the preview, then save the edited document by clicking on "Save".

=¥ Topic Conversation l?] Save

=

Show preview of document

Original document (read-only)

Ornginal document (Edit mode)

2 Tenaska IV Meeting List.xls —
Path: Z\temphTenaska IV Meeting List.xls |E
4 A B C D E
1 Tenaska IV - Gas Supplv Meeting 21-Jun-01 1:00PM -
7 Company Expertise Contact EP Office Phone
3 [EPME Origination David Field N2423A (713 420-4¢
4 EPME Anatysthodeling  [Shane Litts 2445D (713)420-71
5 _FEPRAF Commercial homi Rick Ighnston MRS (1306




The Status Bar

The status bar shows you how many results your search returned, how many items
are currently found in the index, and possibly also the online status of a connected
Lookeen server. During indexing, you can also see which folder is being indexed.

9993 items found 89839 items Online

By clicking on the number of items in the index at the right-side of the status bar,
you’ll open the file lookeen_detailed_index_log.txt from the Lookeen user directory.
This file includes detailed data on the index, such as start and end times of indexing
and the number of indexed items in each folder.



Options

Here you can see the options window. Use this window to define how emails and
files are indexed on your computer, how search queries are processed and how
Lookeen is integrated into Windows.

i~ ™y
m Options l‘:' 5] éj

Index |Index Schedule I Index Details I Search | Outlook | System|

Index sources (Please select which sources Lookeen should search):

[ Add Store... ]

-- [ Pipelines  1item: i

" m Sent [tems 172 items

-7 [ 'Sent Mail 70 items

i [ Storage  Li=m:

-- BBTasks 4 ftems

-- [ Tufce  172items

-7 [08 Wellhead 36 tems

=] Bﬂ farmer-d1

=[] [3 farmer-d2

E| EB Darren_Farmer_Dec2000 A

B Bﬂ Motes Folders

- [¥] [08 All documents 4657 ftems
-- m Ces 285 tems
-- [ Contracts 20 items i
-- EE Cornhusker 32 items

i mﬂ Discussion threads 2786 itzems

m-[¥] {8 'sent mail 430 items
o FF PR i A

m

l Restore Defaults ] l Reset dialog OK I [ Cancel

Index

Here you can specify which folders should be indexed and searched by Lookeen.
If you click the plus sign next to a folder, you can display the subdirectories and
activate each one of them by checking the box, or disable them by un-checking the
box.
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m Options L‘:' 5] ﬂ

Index |Index Schedule | Index Details | Search | Outlook | System|

Index sources (Please select which sources Lookeen should search):

[ Add Store... ]

i [02 Pipelines  Lrems
[0 Sentltems 17z 7zm:
[02 'Sent Mail ~ 70itzms
[07 Storage Liems
[04 Tasks  4items
8 Tufco 172=ms
-] [0 Wellhead 36 tzms
-] 3 farmer-d1
=-[¥] R farmer-d2
2-[# [ Darren_Farmer_Dec2000
2-[#] [(2 Motes Folders
; m@ All documents 4837 items
m Ces 2E5 ftems
mﬂ Contracts 20 items
[0 Cornhusker 52 tems
[02 Discussion threads 2726 ftems

[02 'sent mail 430 7t=ms
=B 1 o, v S o Sl

m

Restore Defaults l l Reset dialog oK ] l Cancel

Tip: The first indexing may take some time to complete. This depends on type
and size of your data. After your data has been initially indexed, the
subsequent indexing operations go much more quickly. This short indexing
process only adds all newly obtained, moved, deleted, or changed items (e.g.
newly created tasks, appointments or new e-mails).

Add Store

Use the "Add Store" button to open a new window in which you can add your local
directories, Outlook folder, external indices (Shared Index) or Lookeen Server to the
list of archives to be indexed and searched by Lookeen. The new file or Outlook
archives will be included in future indexing, the external index source(s) and/or the
Lookeen Server(s) are immediately available.



ra ™y
A Add Store [
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File System Archive  Microsoft Outlook Discover new Lookeen Shared Lookeen Server
Archive Outlook Archives Indesc

File System Archive
Specify a path to a local data directory or click on the "Browse" button to navigate in

a selection window.

Microsoft Outlook Archive
Select an existing Outlook folder or create a new one.

Discover new Outlook Archives

With this button you can have Lookeen manually search for newly added Outlook
archives. In the case of a find, you will be asked if you want to add the archive(s) to
the index.

- )
Lookeen Enterprise ﬁ

Lookeen has detected 1 new Qutlook stores;
LC10-PST

Do you want to add thern to your index now?

la ] ’ Mein l ’ Abbrechen




Tip: "Detect new Outlook archives when Outlook starts”

With this option (tab "Outlook™), you can have Lookeen check on each Outlook
start whether new Outlook archives have been created and haven’t been
added to the index yet.

Lookeen Shared Index
Here you can specify the path to an external index source (Shared Index). More
information about shared index sources can be found in a separate section.

Lookeen Server
Enter the address (URL) and other options for the use of a Lookeen server (see
below).

Remove
You can delete existing directories by selecting them and clicking "Remove".

Edit
If you are using one or more Lookeen Servers, select the desired one in the list and
click on the “Edit” button to configure it.

A Lookeen Server Settings ﬁ

Server-Urd: Timeouwt (n sec.):
http://152.168 2 81/LookeenServer/LookeenService sve 15=

[Use defautt credentials]

User123 i Mydomain

Server state:
Online ‘ Test settings

QK ‘ ‘ Cancel ‘

In this window you can enter or change the URL of the Lookeen server. Additionally,
you can change the timeout interval, after which a server request is canceled. The
default time is 15 seconds.



The "Use default credentials” option is enabled by default. This means that the user's
login information is used for authorization on the Lookeen server. You can disable
this option and specify login information of another user to use the Lookeen Server
with these permissions.

With the "Test Settings" button, you can check the availability of the Lookeen server.

More information about the Lookeen Server can be found at: http://www.lookeen-
server.com

Indexing Schedule

The indexing schedule allows you to specify how often and at what times Lookeen
should perform an update or re-indexing of your data.

m Options = | B eS|
Index Schedule | Index Details | Search | Outlook | System|

Index items automatically, every: [C] Clear index automatically, every:

Fl[rer— 18] [Days

[C] Don't perform index from: [T] Startindexing only during:

8 to 18 19 to |20

Minimum time between indexing (in sec): Minimum time before first indexing starts (in sec):
20 907

Real-time indexing for the File System
Real-time indexing for Outlook

Minimum number of elements before real-time indexing starts:
1=

Restore Defaults l ’ Reset dialog QK ] { Cancel

Index items automatically, every and Clear index automatically, every

You can specify a time interval in which Lookeen should regularly execute an
indexing of your data.

It is advisable to periodically delete your index and completely rebuild it to safely
update old, moved, or deleted entries in your index. You can also enable this option
here. You can also choose whether you will be asked for confirmation before a
rebuild starts.

Don’t perform index from and ‘Start indexing only during

Here you can select the time periods in which re-indexing of new, moved, deleted,
and modified elements will not take place. If you want to set, for example, that
Lookeen will not perform indexing between 8:00 to 18:00, you can check the check
box "Don’t perform index from" and then set the appropriate times.



Note: The "Don‘t index during the period from" prevents your index from
starting during this time. However, an index process that has already been
started before that time will continue until completed.

Minimum time between indexing and Minimum time before first indexing starts

To reduce the load on system resources, you can specify a minimum time that should
pass between two indexing processes. Also you can set the time to wait after starting
Lookeen until the first indexing takes place. The minimum time for this is 90 seconds.

Real-time indexing

Thanks to the real-time indexing Lookeen finds all emails and other data in real time.
The real-time indexing will provide the latest data to all Lookeen users - whether on
Exchange servers, in public folders, Citrix, Terminal Server environments or on the
network. You can also select how many items must be changed before indexing
starts.

Index Details

Here you can specify, among other things, where your index file is saved and which
file types should be indexed.

#' Options =HACE X

IndexS(hedu\E Index Details | Search | Outlook | System

Local index data path
ChUsers\cschmidt\AppData\Lecal\ Lookeen\Index l Change... ‘ I Clear index I

Index files with extensions ("' to index all files):

folder doc msg xls xml ppt htm html tet pdf pps ppix ppsx docx xlsm xlst dsx php rtf bmp png jpg jpeq tif iff gif ods odt odp|

Regulate the speed of the indexing process. A fast indexing will use more of the system's resources while indexing. IMPORTANT: You
can change speed even DURING indexing.

Slow Fast

U

[T Always optimize index
Optimize Index

Maximum characters in preview (reduce this to minimize index space):

1000[%

Restore Defaults ‘ I Reset dialog QK ‘ \ Cancel

Local index data path

Here you can define where the Lookeen index is stored. In addition, you can also see
how many items are currently in your index. By clicking "Delete Index", you can
delete it completely.



Index files with extensions

You can also add additional file formats so that they can also be found. Just add
additional file formats and see if they’ve been indexed! The file extensions that are
supported and tested by us have already been added. If you want to index all kind of
files (not recommended) you can simply specify that with a ' wildcard.

Regulate the speed of the indexing process

Here you can specify how much computing capacity is available for indexing. If you
set the indexing speed to "Fast” more computing capacity will be used by Lookeen
than when you put it on "Slow". If you run resource-intensive applications that are
slowed by the indexing, you should set the indexing speed to "Slow".

If Lookeen indexing runs slower, it requires less computing capacity and other
programs can use the spare capacity.

Always optimize index

Lookeen starts a defragmentation of the index data after indexing if this option is
selected. This makes the indexing take a bit longer than running it without this option
selected.

Query results arrive even faster since this process compresses the size of the index
folder.

Click the “Optimize Index” button to start the optimization of the index immediately.
Please note: This may take some time to complete.

Maximum characters in preview

If you use the Lookeen preview, you can set how many characters of each element
are provided in preview. Since Lookeen indexes your file contents anyway, a larger
number only minimally affects indexing speed, but it increases the amount of hard
disk space needed for the index.

Search
In this sub-menu, you can set specific search parameters of your search.



# Options = | B |

Index | Index Schedule | Index Details | Search | Qutlook | System

Enable global shortcut (Ctrl, Ctrl) to Start Lookeen from Windows
/| Enable shortcut (Ctrl-F) within search dialog

] Use search history to store your search queries

] Activate 'Search-as-you-type' mode

‘ Restore Defaults H Reset dialog ‘ ‘ oK H Cancel H Apply ‘

Enable global shortcut (Ctrl, Ctrl) to start Lookeen from Windows
By pressing the Ctrl key twice, you can open the Lookeen search window.

Enable shortcut (Ctrl-F) within search dialog
This allows you to search using the key combination Ctrl-F.

Use search history to store your search queries
Lookeen remembers the search queries that you’ve made with Lookeen previously.

Activate ‘Search-as-you-type‘mode

If this mode is enabled, Lookeen starts searching while the search term is being
typed. Otherwise, enter the complete search phrase and then press Enter to start the
search.

Repeat search with * -wildcard, when no search result

If there are no results for your search, Lookeen will automatically re-search for your
keyword and append a wildcard to find all possible results.

Repeat search with * -wildcard at begin of query when no search result

As in the previous case, except that this time the wildcard will be inserted before the
search term.

Always use *-wildcard at begin of query
When enabled, Lookeen will automatically add a wildcard before every search term.



Your Email addresses and Aliases of yourself

Here you may include your name, as defined in Outlook, and enter your emalil
address. Lookeen highlights all emails of which you are the sender.

Maximum results to return on each search

This is the maximum number of items that can be displayed in the search results.
Increase this number if you do not see the results you're looking for in the first 5000
returns.

Outlook

With this tab you can set Outlook-specific settings. For example if you want to index
attachments to emails or not.

W Options ol )

| Index I Index Schedule | Index Details I Search ‘ Outlook | System|

Index Outlock Categories

Index Attachments

Skip junk folders and deleted folders

Skip encrypted items (avoids Security Dialog)

[Open Outlock when needed:]

[A\ways open automatically -

[] Detect new Outlook archives when Qutlook starts

Restore Defaults ] I Reset dialog OK ] I Cancel ] [ Apply

Index Outlook Categories

Select this option to index Outlook categories. The indexing speed may drop under
certain circumstances.

Tip: Please note that categories are only searchable after re-indexing. In order
to see the categories in the search window, you have to add the column
"Categories" to your search results window, using ‘Customize Columns’ in
view settings as detailed in an earlier section.

Index Attachments

Attachments are indexed by default. If you do not want to index attachments,
uncheck the box. Although the indexing will be faster, you might not find what you are
looking for.



Skip junk folders and 'Deleted Items' folders
If this option is enabled, these two Outlook folders will not be included in the index.

Skip encrypted items

PST files often have encrypted items. The security protocol of Outlook normally
requires authentication to allow access to these elements. If you want to index
encrypted elements you will be prompted during indexing to confirm file access.

The default setting of Lookeen therefore is set to skip encrypted items. This ensures
that indexing can be done without you being present.

Open Outlook when needed

Outlook needs to be open when Lookeen wants access to Outlook data for searches
or indexing. You can specify how Lookeen opens Outlook when required: with
confirmation, without confirmation or never.

Detect new Outlook archives when Outlook starts

By request, Lookeen can check at startup if new Outlook archives are available that
are not yet included in the list of ready to index archives.

Show confirmation dialog

If the archive search option is enabled and new archives are encountered, this option
lets you select whether you will be prompted for confirmation before the archives are
added to the index or not.

Add new archives to indexing by default

If this option is selected, new archives that are found will automatically be added
without confirmation.

System

Here you can specify, among other things, what language to use within Lookeen, or
whether the Lookeen icon appears in the taskbar.



m Options =HECN X

|Index |Index Schedule | Index Details | Search | Outlook| System |

Settings location:
C\Users\cschmidt\AppData\Local\Lookeen'\lookeensettings.bin

Do not index if one of these (slow) networks is active (network blacklist):

l Choose networks... I

Confirmation dialog before indexing if a slow network is active

Language (Restart required): ’System vl

Log File Detail Level: Clear Log File l l Show Log File [Fu” 'l

Check for Updates

Show icon in System tray

Show Balloon pop up Information

[ Show general warnings

[] Automatic cache cleanup to minimize memory usage

Show warning when application is closed while indexing

Restore Defaults l l Reset dialog QK l l Cancel l l Apply

Settings location
Here you can see the path where Lookeen saves the settings.

Do not index if one of these (slow) networks is active (network blacklist)

With Corporate networks in particular, it is often the case that a particular network
connection is very busy and / or slow. Lookeen has network settings for this reason.
With this feature, you can create a blacklist. The indexing doesn’t start when
networks included on the blacklist are active.

With the "Choose Networks" button, you can display all the available networks. You
can then add all networks and manually delete unwanted ones off the list, or enter
the desired networks in the list manually.

Confirmation dialog before indexing if a slow network is active

Here you are warned again if the indexing starts and the blacklist is active. This
allows you to check again if you want to index with the given settings.

Language
You can choose between German, English and Spanish. Lookeen uses the language
of your operating system by default.



Log File Detail Level

You can choose between different levels of detail for the log file. By default, Lookeen
uses "Full" detail level. You can also view or delete the log here.

Check for updates

Lookeen will automatically check to see if a new version of Lookeen is available
when you start Outlook.

Show icon in system tray

This option adds the Lookeen icon to the taskbar. If you click the icon in the taskbar
with the right mouse button, you can use the basic functions of Lookeen. See also
the "Windows Integration” section.

Show balloon popup information

Lookeen will inform you with a popup notification when the indexing starts in the
background and when it’s finished.

Show general warnings
Lookeen lets you know when warnings occur.

Automatic cache cleanup to minimize memory usage

On older systems or with special settings, it's possible that your system's cache is not
flushed properly. Please check this to save your memory space and to ensure that
the cache is emptied regularly.

Show warning when application is closed while indexing
Lookeen will warn you if it's indexing isn’t completed and you want to stop Lookeen.



Windows Integration

Lookeen offers a quick way to search by using the Lookeen icon in the system tray:

o Search
~  Options

> Bt

| Lockeen Enterprise
11:1]
~ w
Bl%D

By right-clicking on the icon to open the menu, you can enter your search terms
directly into the textbox. Pressing the Enter key or clicking on “Search” opens the
Lookeen window and the search is performed for the term you entered. By double
clicking on the icon, the window opens without Lookeen search term.

You also have the option to open the Options window directly or to close Lookeen.

If you don’t want to use the Lookeen icon in the taskbar, you can disable it in
Options\System.



Outlook Integration

Lookeen integrates itself in two ways into Outlook: with the Outlook ribbon and as a
search bar.

Lookeen in the Outlook Ribbon

ﬂ| ' T — m—
| Home Send / Receive Folder View Lookeen
Search everything... -
s v
Tu:upic
Lookeen | Options

[£1| Conversation

Search Options

You can view the Lookeen tab by clicking on "Lookeen™ in the Outlook ribbon.

One click on the "Lookeen" logo opens the Lookeen window, if it is not already open.
In the text box, you can enter your search term(s) and then start searching by
pressing the Enter key.

When an email is selected and you click on the "Topic" button, Lookeen will display
all of the emails with the same subject of this email.

A click on "Conversation" lists all the emails that were sent between you and the
sender or receiver of the selected email.

A click on "Options" opens the Lookeen options window.

The Lookeen search bar

The Lookeen search bar is normally displayed above the Inbox and can be found in
the same place in all other folders of the Outlook mailbox.

Search Posteingang [Cirl=E) o
Lookeen Search everythine - Conwversation Topic
) P
Arrange By: Date Mewest on top —
4  Todaw

Except for the button to open the options window, the Lookeen search bar contains
the same functionality as the Lookeen tab in the Ribbon.

To open the Lookeen window, click on "Lookeen".

The "Conversation” and "Topic" buttons correspond to the Lookeen tab buttons.



Search words & Query Syntax

Basic query syntax

Dog

Documents mentioning dog

Dog Cat

Documents mentioning dog and cat

Dog Photos - Cat

Mentioning both dog and photos, but not cat

"Dog Breed"

Documents where the term “dog breed” is mentioned

Advanced queries

D?g*

dogs, digger, dagger. The parameter ? stands for any single
character, the parameter * stands for any number of characters.

“Dog Breed“~11

dog and breed within 11 words of each other

Additional search help

subject:dog*

dog, dogs, dogcatcher etc. in the subject line

to:Martin (or from:, cc:, bcc:)

To (including from, CC, BCC) Martin

body:dog

dog in the message body

Store:Archive

searches the search term only in the “Archive” store

folder:Inbox

the search term is only searched for in the “Inbox” folder

date: [YYYYMMDD TO
YYYYMMDD]

the search term is only searched for within the specified time
frame

from:“Martin Welker”

Searches only emails from this sender

-from:“Martin Welker“ (or -
folder:, -store:)

Excludes this person/folder/archive from the search query.

from:sales@lookeen.net

Searches only for emails from sales@lookeen.net

from:sales

Searches only for emails from senders that contain “sales” e.g.
sales@lookeen.net

cat:Private

searches the search term only in elements with category
“Private”




The following table contains all of the search help that you can add to a search term
in the search box:

cc:Name

Searches for the specified name in the cc field

bcc:Name

Searches for the specified name in the bcc field

subject:subject

Searches for the specified term in the subject field

date:[lYYYYMMDD TO

Restricts the search to the specified period. date: [20150101 TO

YYYYMMDD] 20150115] for example, searches for the period 01/01/2015 to
15/01/2015
from:Name Searches for the sender “name”

atts:file name

Searches for emails that have attachments with the specified file
name.

to:Name

Searches for the recipients “name”

fn:file name

Searches for attachments or files with the specified file name

folder:folder name

Searches only in the given folder

typefile type

Searches for the specified data type: mail, attachment, contact, note,
calendar, journal, file

company:company

Searches for the specified company name in contacts

start:Date Searches the dates after the specified date for the beginning. The
date must be specified in the format YYYYMMDD, for example
20150114 for 14/01/2015

name:Name Searches for the specified name in contacts

due:Date Searches in tasks by the specified due date. The date must be

specified in the format YYYYMMDD, for example 20150114 for
14/01/2015

received:Date

Searches for emails that have been received on the specified date.
The date must be specified in the format YYYYMMDD, for example
20150114 for 14/01/2015

sent:Date

Searches for emails that have been sent on the specified date. The
date must be specified in the format YYYYMMDD, for example
20150114 for 14/01/2015

cd:Date

Searches for all kinds of data (files, emails, contacts, etc.) that were
created on the specified date. The date must be specified in the
format YYYYMMDD, for example 20150114 for 14/01/2015

md:Date

Searches for all kinds of data (files, emails, contacts, etc.) that have
been changed on the date indicated. The date must be specified in
the format YYYYMMDD, for example 20150114 for 14/01/2015

idat:Date

Searches for all kinds of data (files, emails, contacts, etc.) that have
been indexed on the specified date. The date must be specified in
the format YYYYMMDD, for example 20150114 for 14/01/2015

cat:Category

Searches for e-mails that match the specified category. Note: The
indexing of categories needs to be enabled in the options menu, and
indexing has already been done with this option enabled.

fname:First Name

Searches the contacts for the specified first name

phone:Number

Searches the contacts for the specified telephone number

location:Location

Searches the calendar for the specified location

body:Text

Searches emails or files that contain the specified text as content

att: file extension

Searches for messages with attachments of the specified type.
Shown are both the email and its attachments.

ext: file extension

Searches for the specified type files and attachments. Related emails
with attachments are not displayed, but can be opened ("Open
underlying item") via the context menu.




Help Options

You can click on "?" in the Lookeen menu bar for the following functions:

Lookeen User Guide
If you click on "Lookeen User Guide", it will open in your browser.

Online Support
Contact us with our online support form at www.lookeen.net

Send Report...

If you have any suggestions for us, or if problems in the use of Lookeen occur,
please use this menu to contact us. This function contains some information about
your installed Lookeen (such as the version number, your log files and your Lookeen
configuration file, etc.) and will create an email for our Lookeen Support Team. You
can change or delete the contents of this email in whole or in part before it is sent
from your computer.

Check for Updates

If you click this button, Lookeen will check if a new version is available - but you need
to be online to do so. If Lookeen has a problem with your proxy settings, your firewall,
your router or some other problems, the update search does not work. However, this
is not a problem: in this case you will be sent to a website, where you will receive
instructions.

Buy and register

When you buy Lookeen you will receive license data from us or one of our authorized
agents, which will allow you to use the full version of Lookeen. Add the Registered
User license from the data sent in the field "Registered User/Organization” and the
license key into the field "Registration Key". Afterwards, please click on "Register".


http://www.lookeen.net/support/

Register Lookeen

Please enter your registration information below and click the
Register button,

Registered User/Organization (see Invoice):

Registration Key:

Register

Do you wantto get a license of Lookeen?

lam a new Lookeen customer.

Lown a license of a previous version of Lookeen and would like to upgrade.

[lost my license key.

Close

Tell a friend

Do you like this program so much that you want to recommend it to others? This
menu makes it easy for you to do so.

About Lookeen

This menu displays the program name, the EULA (End User License Agreement),
some registered copyrights for this version and the current version number.



External Index Sources (Shared Index)

Overview

Normally each user has their own personal index for their data. However, it can be
very useful, not only to have a personal index, but also to search in several Lookeen
indexes. Suppose that in a corporate network, there are many public documents or
large public folders are stored on an Exchange server that need to be used by many
users. Normally, each user would have to bear the personal responsibility to indexing
this data. This, however, relies upon each user to remember and take the time to
index, which changes the way they work, while also increasing network traffic.

With the "Shared Index" feature, a user creates a central index and makes this
accessible to all users. This is simply done by passing-on the index path. Individual
users can now simultaneously browse through personal and external indexes.
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Using the "Shared Index" function

In the options under "Index" you have the option to "Add New Archive" and then by
double clicking on "Lookeen Shared Index" you can integrate new index sources.
Please note: The path to the index source is always the "Reading" directory of the
index!

» Add Store =5
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Important Security Note: The Lookeen index will not have Active Directory
access rights or other rights structures built in - when a user adds an external
source index he has full access to search this data. This means: If the user
who created the external index has more rights than the user who adds the

index, this user may get access to data via the external index for which he has
no authorization. Please take care of to whom you make the external index
sources available and which location you select for the index path.

Generate an external index source

An external source index doesn’t differ in structure from a conventional personal
index.

Tip: If you want to use local or network folders, please make sure that you
include these folders with their UNC path. Simply share the folder first for
network access and add it via "Network". Any user who wants to search or
open the data, must have access to this network resource.

Searching with external index sources

You can exclude external indexes from your search on request, for example, when
you know that the desired data can be found in your local index. To remove indexes
from a search, simply go to the ‘Index’ tab in Options and uncheck the box next to the
index source.

Note that a search of the external index will always take more time to complete than
a search of the local index. If you only occasionally need data from external sources,
it is advisable to keep it turned off. You can re-enabile it for individual searches.

Possible Application Scenarios

- Access to all PST files, even if this is not integrated into your Outlook
- In the corporate network: your public folder can be indexed centrally!
- In the corporate network: centrally index your network documents!

Browse PST files that are not included in the work profile

You know when you need to access important data stored in a PST file that is not
currently bound to your work profile? Lookeen helps you access it!

How To:
1. Create and open a new archiving profile in Outlook. This can be done in the

Control Panel under the menu item ‘Email‘.

2. Embed the desired PST files into the archiving profile.

3. Set the index path (archive index). In Options under the “Index Details” tab,
you can define and see where the index is created.

4. Start the archive index of all PST files.

5. Close the archiving profile and open your personal Outlook work profile.

6. Add the archive index path to your work profile as an external index.



7. Now all PST files can be searched in every search without being included in
the work profile.

Of course, more than one user can add this archive index, which saves time
indexing overall.

Tip: If you find an email within a PST archive that is currently not included in
your work profile, you can include it by simply right-clicking on the found item
and selecting “Open PST File” in the context menu.

Tip: Interested in an automated, server-based index solution of your
enterprise-wide data that won’t burden your network? Send an email to:
sales@lookeen-server.com.
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